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Housekeeping Items

Presentations are sent in advance through the CAS2Net Pay Pool Notices
Posted to What’s New
Available in User Notifications

Enter your email address in chat
if you did not receive it

What's New

W

Pay Pool Notice Presentation Sample

nOS-O?-EOH-. 3y Podl Administr Advisory [PPA Advisory 2023 - 16 CASINet Data Migration Completion] créated by the Program Office
uas 07-2023 - Pay Pool Administrator Advisary (PPA Advisary 2023 - 16 CAS2Net Data Migratior pietion] ereated by the Program Office

I uos 03-2023 - Pay Pool Admenistrator Advisory (Open Foru 23 August CCAS Spreadshests) created by the Program Office
DDE-E]-ZO?!- Tay Pool Administrator Advisony (Pay Pool Advisory 202315 CAS2Net Offline-Data Migration) created by the Program Office
00 07-06-2023 - pay Posl Administrator Advisory (Open Forum july 2023 - CAS2Net-Posigres Stress Test) created by the Program Office

5. Please remember to “Mute” your phone to prevent any background noise and
additional feedback.

6. All Open Forum Sessions will be recorded

7. Each recorded session will be posted to the AcqDemo website (including
presentation slides) at
https://acqgdemo.hci.mil/training.html#cas2netOpenForums
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PPA Advisory 2024-15 System Check for EOY CCAS
Spreadsheets

Macro-Enabled Sub-Panel Meeting Spreadsheet, Macro-Enabled CMS, and
Macro-Enabled Pay Pool Analysis Tool (PPAT)

* Digitally signed version
— 2024 Sub-Panel Meeting Spreadsheet vidigitallysigned.xlsm =
— 2024 CMS vidigitallysigned.xIsm

— 2024 Pay Pool Analysis Tool vldigitallysigned.xlsm

NNNNNNNNNNNNNNNNN

@ Disable VBA macros except digitally signed macros

cation

* Unsigned version

— 2024 Sub-Panel Meeting Spreadsheet vl-.xlsm ol

Developer Mcro Settings

— 2024 cMs v1Unsigned.xIsm =.
— 2024 Pay Pool Analysis Tool vl-.xlsm

Excel > File > More > Options > Trust Center > Trust Center Setting > Macros Settings

There is not a Macro-Free Pay Pool Analysis Tool for 2024

I
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Pay Pool Analysis Tool (PAT)

* The Pay Pool Analysis Tool (PAT) was created to analyze the results of the

Acqm

pay pool process; it provides a view across multiple pay pools.
— AcgDemo Personnel Policy Boards may use this tool to analyze aggregated pay

pool results

* Pay pool managers may benefit by using the PAT to review results as it

offers an analysis that goes beyond the functions of the Compensation
Management Spreadsheet (CMS).

Pay Pool — Supervisors - Employees

Pay Pool(s) — Command - Component

Compensation Management Spreadsheet

Cycle: 2024 Version: v1

The purpose of this spreadsheet s to record appraisal scores and set basic pay rates and contribution-based financial awards.

Download - Download the data file from CAS?Net, then click
on Import to load the file into this spreadsheet

Appraisal Score Entry - Once the file has been loaded, assign categorical and
final scores for each factor, and view reports and graphs.

Score Normalization — Compare score distributions to look for anomalies and
scale differences. Run preliminary pay adjustment scenarios. Set CRI and CA
parameters and assign pay outs to employees.

Data Maintenance — Al additions, deletions, and modifications must be done in
the central database. All columns except for data entry and ‘wild-card” are
locked. To preserve your work, export the data from this spreadsheet and upload
to CAS?Net before changing any information in CAS2Net

Final “G” Setting - This spreadsheet comes with a best estimate of "G." Once
you have been notified that "G"is set, make a final round trip to CAS2Net. The.
final "G" value and related parameters will be includedin the download of your
paypool data.

Final Compensation Setting - After the final round trip to update "G", finalize the
pay adjustments and awards for your pay pool.

Data Upload - Use Export to create a file for uploading the results from your pay
pool to CAS?Net.

Generate Part 1's — First use the fiters to select employees; sort data by
preferred order; then click on the Generate Part | to generate Part | of the
Appraisal Form for each selected employee.

Pay Pool Data
Import View Export

Last Import: 10/8/2024 (10:39:58 AM)(EDT)
Last Export: 10/9/2024 (1:19:41 PM)(EDT)

Last Modified: Use Today

Parameters

Set CRI and CA Parameters
Summary Reports

Rails and RoR Report

Career Path Factor Matrices ranked by Final Score

Summary Statistics of Delta OCS

D

ibution of Delta OCS

Customizable Summary

Scatter-plots of OCS Score by Salary
Current Pay & 2024 SPL  New Pay & 2025 SPL
Part 1 of Appraisal Forms
Open Existing Evaluation
Validate Data, then use the filters to select individuals and use sort to put the data in preferred order.
Part 1 of isal Forms

This tool combines one or more export files from the C

How to use this spreadsheet:

Pay Pool Analysis Tool (PAT)

20241

For Official Use Only / Personal Data - Privacy Act of 1974

(CMS) and provides analysis of the pay pool(s)
results including OCS, RoR, CRI, CA and funding.

Import one or more export files from C¢ (CMS)

Table of Contents
Data
Stati:

Rating Statistics
Distributions by Group *
Distribution Charts by Group *

Pay Pool Data from CMS

Average OCS, Delta OCS and Modal RoR by Rating Official, Sub-panel Mgr, Pay Pool, and Wildcard
Average OCS, Delta OCS and Modal RoR by Career Path and Band

Zone Distributions and RoR by Number and Percent for various groups

D Charts by Pay Pool and Wildcard

Payout Statistics
Payout Charts

Payout Stats by Group *
Payout Charts by Group
Payout Charts by Wildcard *
Funding Statistics
Funding Charts

Net Draw Analysis A

Net Draw Charts *
Enhanced Flexibilities *
CP-B Counts

Salary

Rail Report

Statistics on Salary Increase and Award ($ and %) and Supv Diff by Pay Pool
Above Statistics in Chart Form

Statistics on Salary Increase and Award ($ and %) by various groups and wildcard
Above Statistics in Chart Form

Above Wildcard Statistics in Chart Form

Statistics on Funding Amounts Budgeted and Allocated by Pay Pool

Above Statistics in Chart Form

Summary of Net Draw Statistics by Career Path, Band, and Wildcard

Above Statistics in Chart Form

Time-Off, Proration, and Salary Split Usage by Career Path and Band Combinations
Counts by Career Path and Band Combinations

Average Salary by Career Path and Band Combinations

Report of Rail Zone and OCS Chart for Aggregate Report

Tabs with " include wildcard information

http:/acqdemo.hci.mil
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Pay Pool Analysis Tool (PAT)

Acqm

-
HEEDemo

The Microsoft Excel workbook called Pay Pool Analysis Tool 2024 contains
nineteen visible tabbed worksheets.

The PAT was created for AcqDemo to analyze the results of the pay pool
process; it provides a view across multiple pay pools.

AcgDemo Personnel Policy Boards may use this tool to analyze aggregated
pay pool results.

Individual pay pool managers may benefit by using the PAT to review
results also as it offers an analysis that goes beyond the functions of the
Compensation Management Spreadsheet (CMS).

This Open Forum supplements the PAT User Guide on how to use the
functionalities of the PAT and describes the available reports.

The nineteen tabbed worksheets are described in this document in the
order in which they appear along the bottom of the PAT workbook.

Instructions LT Statistics Rating Statistics Distributions by Group Distribution Charts by Group Payout Statistics *+ + | < CEEEEEEEEESS——

**  Payout Charts Payout Stats by Group Payout Charts by Group Payout Charts by Wildcard Funding Statistics *= 1+ | < G

**  Funding Charts Net Draw Analysis Net Draw Charts Enhanced Flexibilities CP-B Counts Salary RailReport -+ I 4 GEEEE——

I
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Pay Pool Analysis Tool (PAT)

Changes to the 2024 Pay Pool Analysis Tool

BA BB BC BD BE BF | BG | BH |B| B | BK | BL | BM BN | BO | BP | BQ | BR | BS BT BU BV BW BX
Added Added Added Moved

ove
New Basic | Supv/ Team Supv Supv New Supv | New Supv Coming Off Carryover | Computed  Discretionar| Time-Off CA Dollar 2ndCA Final CA | Total Award WUJILEEILEN CA Award > BUTIGEETGRARTLEEILEE Command |CRlIncrease’ Total Award
Pay 2025 Lead Dif i i i Dif i Dif i Retained Award ($) Award y Award ($) Hours Value Discretionar | Award ($) (6] $10k Code (%) (%)
Rate (%) Amt $ Rate (%) Amt $ Pay? Remain y($)

* Data Worksheet - three new columns
— Column BD Supv Differential Amt S
— Column BF New Supv Differential Amt S
— Column BV Command Code)

7



Pay Pool Analysis Tool (PAT)

CMS Worksheets

Contents

Parameters (Funding Statistics, Funding Charts)

Data (149 Columns)

Matrix (no equivalent in PAT)
Rails and RoR (Rail Report)
Delta Stats (Statistics)

Delta Plot (no equivalent in PAT)
Cur OCS (Rail Report)

New OCS (no equivalent in PAT)
Summary (no equivalent in PAT)

Acqm
N
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PAT Worksheets

Instructions

Data (76 Columns)

Statistics

Rating Statistics

Distribution by Group
Distribution Charts by Group
Payout Statistics

Payout Charts

Payout Stats by Group
Payout Charts by Group
Payout Charts by Wildcard
Funding Statistics

Funding Charts

Net Draw Analysis

Net Draw Charts

Enhanced Flexibilities

CP-B Counts

Salary

Rail Report 8
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Pay Pool Analysis Tool (PAT)

* The Pay Pool Analysis Tool (PAT) and User Guide are available in CAS2Net
under Home > Administrator > Pay Pool Notices.

Pay Pool Notices -]
O Home
&¢ Administrator Show 100 w entries Search:
Pay
Select Uploaded Creator Pool Description Notice Viewed
O aeve [zl [ 0[] |1 | ln [
O E 2024-10-01 LEE, JERRY 9000 2024 AcgDemo PAT User Guide 2024 AcgDemo PAT User Guide.pdf 2024-10-
09
O E 2024-10-01 LEE, JERRY 9000 2024 CMS Spreadsheet User Guide 2024 CMS Spreadsheet Us% @Euide.odf 2024-10-
09
Pay Pool Notices 0 E 2024-10-01 LEE, JERRY 9000 2024 CMS v1DigitallySigned 2024 CMS v1DigitallySigned.xism 2024-10-
- 09
O B 2024-10-01 LEE, JERRY 9000 2024 CMS viUnsigned 2024 CMS v1Unsigned.xlsm 2024-10-
09
O E 2024-10-01 LEE, JERRY 9000 2024 Pay Pool Analysis Tool 2024 Pay Pool Analysis Tool 2024-10-
v1DigitallySigned v1DigitallySigned.xIsm 09
O E 2024-10-01 LEE, JERRY 9000 2024 Pay Pool Analysis Tool viUnsigned 2024 Pay Pool Analysis Tool v1Unsigned.xlsm 2024-10-
09
O E 2024-10-01 LEE, JERRY 9000 2024 Sub-Panel Meeting v1DigitallySigned 2024 Sub-Panel Meeting v1DigitallySigned.xIsm 2024-10-
09
O B 2024-10-01 LEE, JERRY 9000 2024 Sub-Panel Meeting v1Unsigned 2024 Sub-Panel Meeting v1Unsigned.xlsm 2024-10-
09

* The PAT must be saved to the same folder as the CMS and its exported files.
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Download PAT File(s) Report

* Exported CMS files may be downloaded by going to Administrator >
Reports > Fiscal Year Based Reports > Download PAT File(s).

* The downloaded PAT files(s) must be saved to the same folder with the
PAT.

22 Administrator

Administrator Reports

Fiscal Year Based Reports =]

Fiscal Year

2024~

CCAS Pay Pool Results
Appraisal Status
- _ e

e, ——— |

Download PAT File(s)

http:/acqdemo.hci.mil 1 O



Download PAT File(s) Report

Administrators will be able to download PAT files for one or more pay pools

based on their assigned organization(s).

Single Pay Pool:

Select Organization(s)

O check All (None checked will run for all organizations)

(9009 - 9009 Pay Pool

Q search

Command Pay Pools:

Select Organization(s)

O check All (None checked will run for all organizations]

=L peMA - DEMA

[ PP5301 - CHIEF OF STAFF

O pps3nz - ag

L1 pp5303 - DCMAP

LI PP5304 - LOG/SAFETY/AIR OPSS/CYBER

L1 pp5305-TD
PP5306 - PMAEI

O pps307 . T¢

O prs308 . FB

L1 PP3320 - DEMAAT
PP3330 - DEMAL

[ pP5340 - DEMAS

] PP5350 - DCMA-GC

[ PPS360 - DCMAE

Component Pay Pools:

select Organization(s)

L] Check &l {None checked will run for all organizations)

1010 - USAASC HO

=1 AR - All Aremiy (1000 Series)
+ [ 1000 - 1000

11001 - ASAALT
11011 - JPEC ARMAMENTS & AMMUNITION
1012 - PEO Awiation
13- PE0 3T
1014 - JPEQ CERND
16 - PEC EIS
11019 - PED IEWAS
Lot - PEQ STRI
1022 - PEC SOLDIER
1024 - 80

http:/acqdemo.hci.mil
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Download PAT File(s) Report

e Depending on your system, you may have to click Extract All to open the
file(s) and save to the folder with the PAT.

i | = | Eiimat cms_to_pat (4).zip — O X
Home Share View Compressed Folder Tools ~ o
AcgDemo Lessons Learned Meeting 24 Feb 2021 IEJJ
=5 Documents &=/ Pictures sl
Extract
9 Windows Nov all
Extract To
B .
T 4 « Do.. » cms_t. v 9] £ Search cms_to_pat (4).zip
~
~ [ Name Type Compressed size
@ pp9009_to_master.csv Microsoft Excel Comma Separ... 6 KB

E Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder:

C:\Users\tgreen\Downloads\cms_to_pat (4) H Browse... ‘

1 item

Show extracted files when complete

12
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Pay Pool Analysis Tool (PAT)

* When opening the PAT, you must Enable Content

= = . -
u AutoSave [P'/ Z) v Q‘ D B W o=x & W = T 2024 Pay Pool Analysis Tool viUnsigned.xlsm - Read-Only - Excel @ No Label pe - [m] X
File Home Insert Draw Pagelayout Formulas Data Review View Automate Add-ins Help Acrobat i3 Comments | [
% | [ara v ===2 o | & = /Q $ E‘.\ @
(] ; A Q () *
v B I U 17 . . ; ©
Paste IE] = &l Number | B Cells  Editing  Sensitivity Copilot Create PDF  Create PDF and
v v 1 1
v & A Z v and Share link Share via Outlook
Clipboard N Font Alignment Styles Sensitivity Add-ins Adobe Acrobat ~
@ SECURITY WARNING Some active content has been disabled. Click for more details. | | Enable Content X
AH46 v i fev v
A B © D E G Ho 1 J K L M N o P a R s T u v w X a
1
2 Pay Pool Analysis Tool (PAT)
3 20241
5 For Official Use Only / Personal Data - Privacy Act of 1974
o
This tool combines one or more export files from the C. (CMS) and provides analysis of the pay pool(s) resutts
7 including OCS, RoR, CRI, CA and funding.
9 How to use this spreadsheet:
10 Import one or more export files from G (CMS)
1" Table of Contents
12 Data Pay Pool Data from CMS
13 Statistics * Average OCS, Delta OCS and Modal RoR by Rating Official, Sub-panel Mar, Pay Pool, and Wildcard
14 Rating Statistics Average OCS, Delta OCS and Modal RoR by Career Path and Band
15 Distributions by Group * Zone Distributions and RoR by Number and Percent for various groups
16 Distribution Charts by Group * Distribution Charts by Pay Pool and Wildcard
17 Payout Statistics Statistics on Salary Increase and Award ($ and %) and Supv Diff by Pay Pool
18 Payout Charts Above Statistics in Chart Form
19 Payout Stats by Group ~ Statistics on Salary Increase and Award ($ and %) by various groups and wildcard
2 Payout Charts by Group Above Statistics in Chart Form
21 Payout Charts by Wildcard # Above Wildcard Statistics in Chart Form
2 Eunding Statistics Statistics on Funding Amounts Budgeted and Allocated by Pay Pool
2 Funding Charts Above Statistics in Chart Form
24 Net Draw Analysis * Summary of Net Draw Statistics by Career Path, Band, and Wildcard
25 Net Draw Charts Above Statistics in Chart Form
2 Enhanced Fle; Time-Off, Proration, and Salary Spiit Usage by Career Path and Band Combinations
27 CP-B Counts Counts by Career Path and Band Combinations
28 Salary Average Salary by Career Path and Band Combinations
29 Rail Report Report of Rail Zone and OCS Chart for Aggregate Report
30 Tabs with * include wildcard information
31 v
> Instructions Statistics Rating Statistics Distributions by Group Distribution Charts by Group Payout Statistics =+ { 4 oSS

13
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Pay Pool Analysis Tool (PAT) — Import File(s

* Import only files with “to_Master.csv”, e.g., pp9000_to_Master.csv

Pay Pool Analysis Tool (PAT)
2024 v1
For Official Use Only / Personal Data - Privacy Act of 1974
This tool combines one or more export files from the Compensation Management Spreadsheet (CMS) and provides analysis of the pay pool(s)
results including OCS, RoR, CRI, CA and funding.
How to use this spreadsheet:
Import one or more export files from Compensation Management Spreadsheet (CMS)
Table of Contents
Data Pay Pool Data from CMS
Statistics * Average OCS, Delta OCS and Modal RoR by Rating Official, Sub-panel Mgr, Pay Pool, and Wildcard
Rating Statistics Average OCS, Delta OCS and Modal RoR by Career Path and Band
Distributions by Group * Zone Distributions and RoR by Number and Percent for various groups
Distribution Charts by Group * Distribution Charts by Pay Pool and Wildcard
Payout Statistics isti E 7 o )
Statistics on Salary Increase and 4 Import X
Payout Charts Above Statistics in Chart Form '
Payout Stats by Group * isti lary | . .
Statistics on Salary Increase and Select CWB Export Files: Arrange Display Order:
Payout Charts by Group Above Statistics in Chart Form
- pp9000_to_CMS.csv
Payout Charts by Wildcard # Above Wildcard Statistics in Chart| PPYUUU TO IMaster.csv
Funding Statistics Statistics on Funding Amounts Bu pp9009_to_CMS.csv
Funding Charts Above Statistics in Chart Form £RI009_to_Master cov
Net Draw Analysis A isti PP9999_to_CMS.csv
Net Draw Analysis %
Summary of Net Draw Statistics b pb9999 to Master.csv .
Net Draw Charts » Above Statistics in Chart Form >> Move Up |
Enhanced Flexibilities * Time-Off, Proration, and Salary Sp|
CP-B Counts Counts by Career Path and Band <<
Move Dowr
Salary Average Salary by Career Path an
Rail Report Report of Rail Zone and OCS Cha
Tabs with * include wildcard information
Note: Holding CTRL+Click selects multiple individual files. Replace All Existing Append this file(s) to
Holding SHIFT+Click selects multiple files in a range. Data with this file(s) ® Existing Data
Open Cancel



Import

Select CWB Export Files:
000_to_CMS.csv

the desired display order.

Arrange Display Order:

Pp900 MS.csv

pp9000_to_Master.csv

Import

Pay Pool Analysis Tool (PAT) — Import File(s

Acqm
HE
HEEDemo

* In the Import dialogue box, use the arrows to move the files to the PAT in

PP9009_to_Master.csv
Pp9999_to_CMS.csv
Pp9999_to_Master.csv

Note: Holding CTRL+Click selects multiple individual files.
Holding SHIFT+Click selects multiple files in a range.

Move Up

Move Dowr

 Replace All Existing Append this file(s) to
Data with this file(s)

Existing Data

Open Cancel

* Click

==

Select CWB Export Files:

Pp9000_to_CMS.csv
Pp9000_to_Master.csv

Arrange Display Order:

Pp9009_to_CMS.csv
Pp9009_to_Master.csv

Note: Holding CTRL+Click selects multiple individual files.
Holding SHIFT+Click selects multiple files in a range.

pp9999_to_CMS.csv
pp9999_to_Master.csv
>>

<]

Pp9000_to_Master.csv
Pp9009_to_Master.csv
Pp9999_to_Master.csv

@ Replace All Existing

e Append this file(s) to
Data with this file(s)

Existing Data

Open Cancel

X 1

Move Up

Move Dowr

* Click

Open

to move file(s) for the PAT

Import

Select CWB Export Files:

... Error if importing pp####_to CMS

Import

b3
Arrange Display Order:
PPI000_to_CMS.csv PPI000_to_Master.csv
to_Master.csv pp900
pp9999_to_CMS.csv
PPI999_to_Master.csv
pp9999_to_CMS.csv
PP9999_to_Master.csv
> Move Up
< Move Dowr
Note: Holding CTRL+Click selects muliple individual files. Replace All Existing P ED
Holding SHIFT+Click selects multiple files in a range. @ | Data with this file(s) Existing Data
Open Cancel

http:/acqdemo.hci.mil

The file "C:\Users\jalee\OneDrive -
DAU\erry\CCAS\2024\9000\pp9999_to_CMS.csv"

does not appear to be a valid import and will not be imported.

e Click OK

15



See pop-up
Save ... Data successfully imported! Would you like to save the spreadsheet?

Pay Pool Analysis Tool (PAT) — Import File(s)

A B c D E F G H J K M N (@) R
1]
2
3 Rails Report
4
5] NH NJ NK . e
6 Rail Zone Number  Percent | Number  Percent | Number ' Save on of Rail Zone Rating of Record
7 A 0 0.0% 2 15.4% 0 ‘iately compensated above the rails Unacceptable (Level 1)
8 Cc1 12 19.4% 2 15.4% 0 tely compensated between the rails > SPL Fully Successful (Level 3
9 c2 45 72.6% 9 69.2% 13 Data successfully imported! tely compensated between the rails <= SPL Outstanding (Level 5)
10 B 5 8.1% 0 0.0% 0 | Would you like to save the spreadsheet? iately compensated below the rails Total
11 Total 62 100.0% 13 100.0% 13 |
12 Counts do not include personnel receiving presumpti : ) ) Modal
14 Raii.
15
16 NH NJ NK Total
17 Rail Zone Number Percent Number Percent Number Percent Number Percent Definition of Rail Zone
18 A 0 0.0% 2 15.4% 0 0.0% 2 2.3% Inappropriately compensated above the rails
19 C 57 91.9% 1" 84.6% 13 100.0% 81 92.0% Appropriately compensated between the rails
20 B 5 8.1% 0 0.0% 0 0.0% 5 5.7% Inappropriately compensated below the rails
21 Total 62 100.0% 13 100.0% 13 100.0% 88 100.0%
22 Counts do not include personnel receiving presumptive OCS ratings due to time
23
24
25
E | | | | | 777 ]
< =+ Net Draw Analysis Net Draw Charts Enhanced Flexibilities CP-B Counts Work Salary ~ RailReport AF 4 NN

»

16



Acqm
HE
HEEDemo

Pay Pool Analysis Tool (PAT)

* Once the files are uploaded to the PAT, you can rename Pay Pools to
customize as desired.

— Go to Add-Ins > Customize

File Home Insert Draw Page Layout Formulas Data Review View Automate Add-ins Help Acrobat

E@ Copy D< Import Mo o = = = Ml v Zl Q MainMenu W Wildcard Stats 1?8 Customize Output Charts ’_‘

— Select a pay pool
— Click Rename > Enter Name > Click Rename

Customize % Originally: 9000 X Customize X
& Pay Pools  Wildcard , Provide a new name for the Pay & Pay Pools C Wildcard
Move pay pools into the desired order ool | Move pay pools into the desired order
9000
9009 9009
9999
Move Up Rename | Revert | Close | 9999 Move Up
ez e Originally: 9000 X Move Down
Provide a new name for the Pay
Delete All Pool
mj sk Macro-Free| [~ Delete All
ﬂl Delete |
Sort Close ' Rename Revert | Close |
Rename Sort Close e
1 N )
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Pay Pool Analysis Tool (PAT)

* To reorder a pay pool in the proper sequence:
— Go to Add-Ins > Customize

File Home Insert Draw Page Layout Formulas Data Review View Automate Add-ins Help Acrobat

E@ Copy D< Import Mo o = = = Ml v Zl Q MainMenu W Wildcard Stats 1?8 Customize Output Charts ’_‘

— Select a pay pool > click Move Up or Move Down to the desired placement >
click Sort

e Click OK to confirm.

E a 1 1 o K Customize X Customize X L E a H 1 A L M
1 | = i i : @ Pay Pools € Wildcard Move Down @ Pay Pools € wildcard 1 | £ =
Move pay pools into the desired order Move pay pools into the desired order 4
Y Y ‘5 -
= Lol | 0 J‘:I"i hi‘l. ‘,!IH L) trove porn A £l ] T llH: :I!"E -
181 E § L o ?
: i ! 1 8 1 8 Move Up : 8 8 1 1
[ H & L & b L I~ Delete [ " 1 o E ] &
T PISTITEEE. BTG BN MTE WTITANT MR B TEISM T PR ELTELSM BTITHEIT M EIE N K10 IS TS B0TH I
B SITOEBLEYT] JEUTRACH 128 M4 T BT IR HI SO KEINNaTY ’—| Delete L] FIPTRMRM | ERIVNITH BTN H2 R 1 K004 7| BROTEEIE
¥ o 1 [ o E Sort Close ¥ 5 [ P2 1 [
: K I I R I =y Sort | & K I IR e R
" L b " ah b
[F] ~ e - e [F] ~n e -~
3 Dmction  Cacreior 3 ~a Dmcrwiom| Decopion
] ]
15 15 1 |
" "
L) e it 2 30% 300 1 300% it T L) TN R 2 3% T I 2 300%
4 r o Tl St Tanderg Charty hisrt D gy syl Mot Dups Ctn [ 4 r o Tendleg Slaiistkn oo Chartt Yot Dvm Arudyn et Dupw Charty Erbarcwd

Microsoft Excel X

lf/\\ )
Pay Pool Sort is complete

— 18




Pay Pool Analysis Tool (PAT) - Wildcards

* Some worksheets in the
Pay Pool Analysis Tool can
be supplemented with
Wildcard columns that
provide subsets of data to
aid in your analysis.

Acqm
N
B EEDemo

PAT Worksheets

Data

Statistics with Wildcard if selected

Rating Statistics

Distribution by Group with Wildcard if selected
Distribution Charts by Group with Wildcard if selected
Payout Statistics

Payout Stats by Group with Wildcard if selected
Payout Charts by Group

Payout Charts by Wildcard with Wildcard if selected
Funding Statistics

Funding Charts

Net Draw Analysis with Wildcard if selected

Net Draw Charts with Wildcard if selected
Enhanced Flexibilities with Wildcard if selected
CP-B Counts

Salary

Rail Report

http:/acqdemo.hci.mil 1 9
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Pay Pool Analysis Tool (PAT)

* There are 8 Wildcard columns spaced across the Data worksheet and are
open for editing.
e Wildcards may be used to review subsets of data to aid in your analysis.

— Suggestion: Review the results by geographic regions, work teams, or some
other criteria not defined by an existing column on the spreadsheet.

— Wildcard data that existed in the CMS files you imported will be available in the
PAT.

Wildcard 1 Wildcard 4 Wildcard 5 Wildcard 6 Wildcard 7 Wildcard 8
: . = . -] v [~ -

* You can change the wildcard groupings used in the PAT by selecting the
Wildcard Stats button on the Add-ins menu bar.

File Home Insert Draw Page Layout Formulas Data Review View Automate Add-ins Help Acrobat
EBCOPY B{Import e ol = = = Ml ? Zl c%MainMenu W Wildcard Stats ?E Customize OutputCharts

http:/acqdemo.hci.mil 2 O
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Pay Pool Analysis Tool (PAT)

* Only Wildcard columns with data in them will show as available to use in
the Select the “Column to be used in statistical reports” drop down field.

— Empty Wildcard columns will not populate in the drop-down field

File Home Insert Draw Page Layout Formulas Data Review View Automate Add-ins Help Acrobat
(3 copy (% import I = E E Ml N2 21 @\ MainMenu | W Wildcard Stats  {§ customize  [2) Output Charts

* Click on the Wildcard column to be used and select Run Statistics.
— Default options include the Subpanel and Office Symbol columns

Column Selection X Column Selection X Column Selection X
Select the column to be used in Select the column to be used in Select the column to be used in
statistical reports statistical reports statistical reports
| --Select-- j —Select-- j | Wildcard 1 j
Subpanel
’ a Office Symbol ] a
un ear Wildcard 1 un ear
Statistics Statistics Cancel W:I q ca:d 5 Statistics Statistics Cancel
Wildcard 3
Wildcard 5
’ . . . . .
— You'll receive a message indicating the action was successful
Wildcard Data X

l

o Wildcard tables and charts successfully updated
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Pay Pool Analysis Tool (PAT) _—

* Note that you can also remove previously generated statistics by the
Wildcard columns in this box.

Column Selection X Column Selection X Column Selection X
Select the column to be used in Select the column to be used in Select the <_:o|_umn to be used in
statistical reports statistical reports statistical reports
| --Select-- j —-Select-- . | Wildcard 1 j

--Select--
Subpanel
Run Clear Run Clear
Statistics Statistics Leree Office SﬁmbOI Statistics Statistics Cancel
-1 Wildcard 2
| Wildcard 3
Wildcard 5

— You'll receive a message indicating the action was successful (you may need
to select Cancel to close the Custom Selection box

Microsoft E:((;e—l- I X Column Selection X
Select the column to be used in
Wildcard Charts and Tables have been cleared statistical reports
| Wildcard 1 j
OK
y Run Clear Cancel
Statistics Statistics

e



Pay Pool Analysis Tool (PAT) — Wildcard Display

* To reorder a Wildcard to a different sequence:

— Select a Wildcard > click Move Up or Move Down to the desired placement >
click Sort

File nsert

Home

Click OK to confirm.

Review View [

Tell me what

Ellj Import 12 Hide 1 Unhide £ Unhide All 2% Hide =] Unhide (Il Unhide All T Clear All Filters 4] Sort ' MainMenu W Wildcard Stats | & Customize =] Output Charts [2 Generate Aggregate Report

Sort

A B c | D E E o | H | | 0 Customize X
1 Composite P: Customize X
2 - | « vt C Pay Pools ® Wildcard
A Pay Pools Wildcar
3 e o Move wildcards into the desired order
. Move wildcards Into the desired order Move Down
5 Entire Population 775 Divicion 1 oV uper
s Rating Official Division 2 [[;!V!S!On ;
ing Officia Divicion 3 ivision
8 (=l Division 3 Move Up
9 ACDP SUPERVISOR 503
10 AMERICAN ROBIN 786
1 DEWEY WOODPECKER 798
12 PAY POOL MANAGER 870 Move Down Move U p Foelom
13
14 Sub-Panel Manager
15
16 PAY POOL MANAGER 830
17
18 Pay Pool
19|
20 9009 78 Sort Close
21|
22| Division
23
24| Division 1 786 04 5 5 5
25| Division 2 798 08 3 5 4
26| Division 3 503 00 3 7 4
27| Supenisors 970 10 3 3 3
28
, Instructions Rating Statistics | Distributions by Group | Distrik
Microsoft Excel et
P
p

—J

Iu Wildcard Sort is complete

A B c D E F G H 1 J
1 Composite Pay Pool Statistics
2
Average  Average  Modal  Numberof Employees
3 Rating Delta OCS RoR Employees Rated
4
5 Entire Population 775 05 3 20 16
6
7] Rating Official
8
9| ACDP SUPERVISOR 593 00 3 7 4
10 AMERICAN ROBIN 786 04 5 5 5
1 DEWEY WOODPECKER 798 08 3 5 4
12 PAY POOL MANAGER 97.0 10 3 3 3
13
14 | Sub-Panel Manager
15
16 PAY POOL MANAGER 830 00 5 1 1
17
18 Pay Pool
19
20 9009 75 05 3 20 16
21|
22 Division
23
24 Supenisors 97.0 10 3 3 3
25 Division 1 786 04 5 5 5
2 | Division 2 798 08 3 5 4
27| Division 3 503 00 3 7 4
28
< Statistics | Rating Statistics | Distributions by Group | Distribution Charts by Group

23
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Pay Pool Analysis Tool (PAT) —
* Another feature is that the Wildcard column can be renamed in the dark
green cell above the column.

— This will provide more meaningful titled statistics and charts for analysis and
review

s ciam 10 Re-Name the Wildcard:

e (1) Select the column
heading

— enter the name of the
column

Or

e (2) Select Wildcard
column

— Place cursor + on cell
immediately below
Wildcard BUE vs NBUE

— Use the up arrow on
your keyboard to move
cursor to the green area

— Enter the name of the
column

SSSSSSSS

— 24
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Individual Worksheet Overview
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Data Worksheet

The Data worksheet contains pay pool data from the CMS.

There are 76 visible columns in the worksheet. The columns contain data
such as ratings, salary increases and awards that were calculated during
the pay pool process using the CMS.

Columns are read-only with the exception of the Wildcard columns.

Cells E1 and E2 displays the number of pay pools and employees loaded in
the PAT.

A B C D =
1 Remove Paypools] 3
Name and |D
2 : Employees| 94

Wildcard Columns

There are 8 Wildcard columns, as we discussed earlier, spaced across the
worksheet and they are open for editing. Wildcards may be used to review
subsets of data to aid in your analysis. You may want to review the results
by geographic regions, work teams, or some other criteria not defined by
an existing column on the spreadsheet. Wildcard data that existed in the
CMS files you imported will be available in the PAT.

I

-
HEEDemo
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Data Worksheet

e 76 visible columns are read-only

except fo

r the Wildcard columns.

A B C D E F G | J K L M N [©) B Q
1 Remove Paypools: 3
Name and ID
2 Employees: 94
Last Name First Name EDIPI CAS2NetID| Pay Pool Subpanel Office Symbol Wildcard 1 [3 % B < £ ° E Occ Series CY2024 Ratable | Locality Code | 2024 Locality
22 £8 & 5 K Basic Pay | Temp Rate
£3 2 5 3 Promoti
H [ 2 S on
2 o o
3 M - - - v - - a v - - - - - - - -
R S i U \4 w X Y 4 AA AB AC
CY2024 Pay Usedin Award | Previous | Previous | StartDate CA CRI CA Rollover 1st Level Sup Name Sub-Panel Manager's Pay Pool Manager Name
Used in CRI Funding ocs Rating of Proration | Override? @ Override? | CRIto CA? Meeting
Calculations  Limitation Record
- - - - - - - - - - - -
AD AE AF AG AH Al AJ AK AL
Ratings . .
e Avg: Avg:
Shares 717 1.1
Wildcard 2 Wildcard 3 Expected | 2024 OCS | Delta OCS Raw Rating of |Rail Pos (Final)
ocs Average Record
Rating
= = 2 G I N N 2 B -
AP AQ AR AS AT AU AV AW AX AY AZ BA BB BC BD BE BF BG BH
Salary New New
Increase
Wildcard 4 (Default CRI) | Discretionary | Computed Split % to Allow to On ACDP? | Last ACDP | Last ACDP % | Control Point | Allow Over | Approved New Basic | Supv/ Team Supv Supv New Supv New Supv Coming Off
AlphaiDeltaY CRI CRI$ Salary Exceed Date Used in Control CRI ($) Pay 2025 Lead Differential @8 Differential EDifferential Rate @Differential Amt Retained Pay?
20% limit Calculations Point? Rate (%) Amt$ (%)
- - 4~ = = 1+ == F ] B -]
Bl BJ BK BL BM BN BO BP BQ BR BS BT BU | | BV | IR BX
Awards N ew
Carryover Computed  |Discretionary | Time-Off CA Dollar 2nd CA Final CA Total Award ($) Wildcard 6 CA Award > Wildcard 7 Wildcard 8 Command CRI Total Award
Award ($) Award Award ($) Hours  |Value Remain| Discretionary Award ($) $10k Code Increase (%)
($) (%)
- - - - - - - - -

http:/acqdemo.hci.mil
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Statistics Worksheet

The Statistics worksheet provides the average rating, average delta OCS,
modal rating of record, number of employees and number of employees

rated the entire population, pay pool, career path, broadband, career

path/band, and, if selected Wildcard (in this case, Office Symbol was copied

to Wildcard 1).

Without Wildcard Stats

A B8 c
71 Only visible rows from Data tab
2
3]
4
5
6 Entire Population
T
8 Pay Pool
a
10 9000
11 9009
12 9999
13
14 Sub-Panel
15
16 9000
17 9009
18 9999
19 9000-5p-Friday
20 5000-Sp-Mondary
2 9000-5p-PPP Members
22 9000-Sp-Thursday
23 9000-5p-Tuesday
24 5000-Sp-Wednesday
25 9009-1
26 9009-2
27 90093
28 90094
29 D009-HO
30
i Rating Official
a2
33 ACDP SUPERVISOR
34 AMERICAN ROSIN
35 ASHLEY CARTER
36 BRETT HOLMES
w DEWEY WOODPECKER
38 ERIN MURRAY
39 JERRY LEE
40 PAY POOL MANAGER
41 SUPER USER
42
43

Note:

Employees in a Presumptive Due to Time

D E F G
C ite Pay Pool

Avernge  Average  Modal
Rating DelaOCS  RoR
723 12 3
746 11 3
655 1.0 3
T8I 21 3
1000 oo 3
460 1.0 3
783 21 3
T3 20 a
63 14 3
8.0 05 5
842 or 3
645 or 3
Ti9 12 3
810 1.8 3
ear 05 3
580 or 3
B05 15 3
685 12 3
65.0 28 3
588 25 3
0.3 8 3
T30 20 3
644 o0 3
580 20 3
752 11 2
832 0E 3
560 0s a

Number of
Employess

94

62
i}

YT Jr

Employwres ™
Rated

a8

10

PAPIE PIO

W Wildcard Stats

A B c
I Onily visible rows from Data tab

Entire Population

Pay Pool

9000-Sp-Fricay
9000-Sp-Monday
9000-Sp-PPP Members
9000-Sp-Thursday
9000-Sp-Tuesday
9000-Sp-Wednesday
B005-1

9005-2

9005-3

20094

9009-HO

Rating Official

ACDP SUPERVISOR
AMERICAN ROSIN
ASHLEY CARTER
BRETT HOLMES
DEWEY WOODPECKER
ERIN MURRAY

JERRY LEE

PAY POOL MANAGER

SP-1-Monday
SP-2-Tuesday
SP-3-Wecnesday
SP-4-Thursday
SP.5-Friday

(4] E F G
Ci Pay Pool
Aversge  Averags  Modal
Rating DelaOCS  RoR
723 1.2 3
T4E 11 3
B55 1o 3
83 21 3
100.0 o 3
4850 1.0 3
T8I 21 k]
T 20 3
L 1.4 3
cao o8 35
B4a2 or 3
G458 or a
a9 12 a
81.0 18 3
8a7 (13 3
580 07 3
805 15 3
685 12 3
9.0 25 3
585 5 3
To.3 28 3
T30 20 3
644 o6 3
580 20 3
T2 1.1 3
o8 3

H

Number of
Employeos

94

62
]

P PP

Employres ™
Rated

L]

bog-vsnaan
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Rating Statistics Worksheet

A B C D F G H J
™ Only visible rows from Datatab

Rating Statistics

* The Rating Statistics worksheet
displays average OCS, average
delta OCS and Modal Rating of & e e S e

e

Record for each career path and & oo T T = :
broadband level. o[ I

* The Overall column shows the | | owe | ow
combined averages for all u = ss | w0 | o
imported pay pools and columns | | bl I

to the right show averages for G | e oo | sro | e | e

each individual pay pool. B 3 N 3 |

— Note: Employees in a 1 I - s b y e
Presumptive Due to Time are not |= 40 00
included iZ N4 15 B
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Distributions by Group Worksheet

* The Distributions by Group worksheet provides 3 sets of distribution tallies by

counts and percentages of employees by
— Zone distribution
— Performance rating
— Raw average PAQL across a variety of groups
* Distributions are shown by the entire population, pay pool, career path,
broadband, career path/band, and, if selected, Wildcard.

— Note: Statistics on this worksheet exclude Presumptive Due to Time

B E F G H J K L M N o P Q R s T u v w X Y z AA AB AC AD
I Only visible rows from Data{ab Distribution by GrouP
2 Does not include presumptive due to time
3 Number of Zone Distribution Rating of Record Distribution Raw Average PAQL Distribution
Employees
1 Not Rated A 1 c2 B A c1 c2 B 1 3 5 1 3 5 Maodal RoR 1.0 3.0 37 4.3 5.0 1.0 3.0 37 4.3 5.0
5
6 Entire Population: 6 2 14 67 5 2.3% 15.9% 76.1% 5.7% 2 80 6 2.3% 90.9% 6.8% 3 2 78 2 2 4 2.3% 88.6% 2.3% 2.3% 4.5%|
7
8 PayPool
9
10 9000 6 1 13 39 3 1.8% 232% 69.6% 5.4% 1 50 5 18% 89.3% 8.9% 3 1 50 0 1 4 1.8% 89.3% 0.0% 18% T1%
11 9009 0 1 1 22 1 4.0% 4.0% B88.0% 4.0% 1 24 0 4.0% 96.0% 0.0% 3 1 22 2 0 0 4.0% B88.0% 8.0% 0.0% 0.0%
12 9999 0 0 0 6 1 0.0% 0.0% 85.7% 14.3% 0 6 1 0.0% B85.7% 14.3% 3 0 6 0 1 0 0.0% 85.7% 0.0% 14.3% 0.0%
13
14 career Path
15
16 NH 3 0 12 45 5 0.0% 19.4% T72.6% 8.1% 0 58 4 0.0% 93.5% 6.5% 3 0 56 2 1 3 0.0% 90.3% 32% 1.6% 4.8%
17 |NJ 2 2 2 9 0 15.4% 15.4% 69.2% 0.0% 2 10 1 15.4% 76.9% T7% 3 2 10 0 1 0 15.4% 76.9% 0.0% T7% 0.0%
18 NK 1 0 0 13 0 0.0% 0.0% 100.0% 0.0% 0 12 1 0.0% 92.3% T7% 3 0 12 0 0 1 0.0% 923% 0.0% 0.0% T7%
19
20 Band
21
221 0 0 0 2 o 0.0% 0.0% 100.0% 0.0% 0 2 0 0.0% 100.0% 0.0% 3 0 2 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
232 1 1 0 19 2 45% 0.0% 86.4% 9.1% 1 20 1 45% 90.9% 45% 3 1 20 0 0 1 45% 90.9% 0.0% 0.0% 45%
243 5 1 10 30 2 23% 23.3% £9.8% 47% 1 4 1 23% 95.3% 23% 3 1 39 2 0 1 23% 90.7% 47% 0.0% 23%
254 0 0 16 1 0.0% 19.0% 76.2% 48% 0 17 4 0.0% 81.0% 19.0% 3 0 17 0 2 2 0.0% 81.0% 0.0% 95% 95%
26
27 Career Path/Band
28
29 NH-2 1 0 0 11 2 0.0% 0.0% 84.6% 15.4% 0 13 0 0.0% 100.0% 0.0% 3 0 13 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
30 NH-3 2 0 10 20 2 0.0% 313% 62.5% 6.3% 0 3 1 0.0% 96.9% 31% 3 0 29 2 0 1 0.0% 80.6% 6.3% 0.0% 31%
31 NH-4 0 0 2 14 1 0.0% 11.8% 82.4% 5.9% 0 14 3 0.0% 82.4% 17.6% 3 0 14 0 1 2 0.0% 82.4% 0.0% 5.9% 11.8%
32 NJ1 0 0 0 1 o 0.0% 0.0% 100.0% 0.0% 0 1 0 0.0% 100.0% 0.0% 3 0 1 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
33 NJ-2 0 1 0 1 0 50.0% 0.0% 50.0% 0.0% 1 1 0 50.0% 50.0% 0.0% 13 1 1 0 0 0 50.0% 50.0% 0.0% 0.0% 0.0%
34 NJ3 2 1 0 5 0 16.7% 0.0% 833% 0.0% 1 5 0 16.7% 83.3% 0.0% 3 1 5 0 0 0 16.7% 833% 0.0% 0.0% 0.0%
35 NJ-4 0 0 2 2 o 0.0% 50.0% 50.0% 0.0% 0 3 1 0.0% 75.0% 250% 3 0 3 0 1 0 0.0% 75.0% 0.0% 250% 0.0%
36 NK-1 0 0 0 1 o 0.0% 0.0% 100.0% 0.0% 0 1 0 0.0% 100.0% 0.0% 3 0 1 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
37 NK-2 0 0 0 7 o 0.0% 0.0% 100.0% 0.0% 0 6 1 0.0% 85.7% 14.3% 3 0 6 0 0 1 0.0% 85.7% 0.0% 0.0% 14.3%
38 NK-3 1 0 0 5 0 0.0% 0.0% 100.0% 0.0% 0 5 0 0.0% 100.0% 0.0% 3 0 5 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
39
Wildcard [} e
41
42 19009 0 0 0 1 0 0.0% 0.0% 100.0% 0.0% 0 1 0 0.0% 100.0% 0.0% 3 0 1 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
43 9999 0 0 0 6 1 0.0% 0.0% 857% 14.3% 0 6 1 0.0% 85.7% 14.3% 3 0 6 0 1 0 0.0% 85.7% 0.0% 14.3% 0.0%
44 9009-1 0 0 0 4 0 0.0% 0.0% 100.0% 0.0% 0 4 0 0.0% 100.0% 0.0% 3 0 3 1 0 0 0.0% 750% 250% 0.0% 0.0%
45 19009-2 0 0 0 6 0 0.0% 0.0% 100.0% 0.0% 0 6 0 0.0% 100.0% 0.0% 3 0 6 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
46 9009-3 0 1 0 4 1 16.7% 0.0% 66.7% 16.7% 1 5 0 16.7% 83.3% 0.0% 3 1 4 1 0 0 16.7% 66.7% 16.7% 0.0% 0.0%
4T 9009-4 0 0 0 2 0 0.0% 0.0% 100.0% 0.0% 0 2 0 0.0% 100.0% 0.0% 3 0 2 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
48 9009-HQ 0 0 1 5 0 0.0% 16.7% 83.3% 0.0% 0 6 0 0.0% 100.0% 0.0% 3 0 6 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
49 SP-1-Monday 0 0 4 6 1 0.0% 36.4% 54.5% 9.1% 0 11 0 0.0% 100.0% 0.0% 3 0 11 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
50 SP-2-Tuesday 1 1 2 7 0 10.0% 20.0% 70.0% 0.0% 1 8 1 10.0% 80.0% 10.0% 3 1 8 0 0 1 10.0% 80.0% 0.0% 0.0% 10.0%
51 8P-3-Wednesday 1 0 2 8 0 0.0% 200% 80.0% 0.0% 0 9 1 0.0% 90.0% 10.0% 3 0 9 0 0 1 0.0% 90.0% 0.0% 0.0% 10.0%
52 SP-4-Thursday 2 0 5 5 0 0.0% 50.0% 50.0% 0.0% 0 9 1 0.0% 90.0% 10.0% 3 0 9 0 1 0 0.0% 90.0% 0.0% 10.0% 0.0%
53 SP-5-Friday 2 0 0 8 2 0.0% 0.0% 80.0% 20.0% 0 10 0 0.0% 100.0% 0.0% 3 0 10 0 0 0 0.0% 100.0% 0.0% 0.0% 0.0%
54 Supenisors 0 0 0 5 0 0.0% 0.0% 100.0% 0.0% 0 3 2 0.0% 60.0% 40.0% 3 0 3 0 0 2 0.0% 60.0% 0.0% 0.0% 40.0%
55
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Distribution Charts by Group

* The Distribution Charts by Group worksheet displays zone and rating of
record distribution by pay pool and wildcard.

* The top charts are bar graphs displaying zone distributions overall and by
each pay pool loaded in the PAT.

* The bottom charts show the distribution by the Wildcard groupings.

out Wildcard Stats W Wildcard Stats

L
py—; T T 3 3 & T =t - B S RS} py— E T 3 3 G = T T S S F A ——
Zone Distribution by Pay Pool Rating of Record Distribution by Pay Pool Raw PAQL Distribution by Pay Pool 1 Zone Distribution by Pay Pool Rating of Record Distribution by Pay Pool Raw PAQL Distribution by Pay Pool
:
i
oo Zone Distrbution by Pay Pool Rating of Record Distrbution by Pay Pool Raw PAQL Distibution by Pay Pool £ Lo Zone Disrbtion by Pay Poct Rating of Record Distibution by Pay Pool Raw PAQL Distibution by Pay Pool
- H oo oo
7
o o i | o o
B
s —== o — Bl faw —= o — o o
f— i i ey
o n o = B fow —w - — o e
o jwui W i o o
2% 2% '5 2% 2%
% £
v
o o Bl |- o o .
S o e o s s H . < 3 P s T s s T s
2
L) T 2 B [esPated] 7 T 317 [ 23 [ 3 [ 37 [ 43 [ 5 ] 21 Rated L3 Rated 5 Pated] 1 1T Z23 3 3T a3 5
[Owecall |88 2% [ 0Ga | 00¢ | @86% | 234 | 234 | asa | 2 [Oserall &8 237 LE7 Tt [Overall & 23 BE% [Cuerall & T3 0% U0 | @ex | 2% 23 TS
[0t | a2 = i 1 o - 17 7 7 7 1 o 7
7 7 17 7| = = it 173 o .7 17 € 7 17 7 7 7 ] 7
o 7 Fill 2 oo s ey 72 2 1 T . 1720 170 T 7 72 P T T
2 Zone Distribution by Rating of Record Distribution by Raw PAQL Distribution by ‘one Dis ion by VVilacare ng. ecor istribution by Wildcare aw istribution by Wildcar
| Zone Distribution by Wildcard 1 Rating of Record Distribution by Wikdcard 1 Raw PAQL Distribution by Wildcard 1
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Payout Statistics Worksheet

* The Payout Statistics worksheet

provides statistics on salary increases,
awards and related data across all pay

pools and by each pay pool.

* The majority of the worksheet
provides the minimum, average,

median, and maximum in terms of
dollar amounts and percentages for

salary increases and awards.

— Note: Presumptive Due to Time
employees are not included

Analyzed Population

Average OCS

Average Delta OCS

Alpha 1 (CRI)

Alpha 2 (CA)

Flags
Override CRI
Override CA
Disable Rollover (0)
Force Rollover (2)

CA Award $
Min (non-zero)
Average
Median

Max

A

B €
I Only visible rows from Datatab

Payout Statistics
Analyzed population excludes
Presumptive Due to Time

Salary Increase $
Min (non-zero)
Average
Median

Max

Control Points
# with CP Entered
# Stopped At CP

Salary Increase % of Basic Pay
Min (non-zero)
Average
Median

Max

Supervisor Differential
Number Receiving

old % Average *

new % Average *

CRI Split to Salary
# with Split Entered

Average Split % Entered

Carryover Award $
# Carry Over Awards
Min (non-zero)
Average”
Median™

Max

CA Award % of Total Pay
Min (non-zero)
Average
Median

Max

Carryover Award % of Basic Pay
Min (non-zero)
Average”
Median™

Max

Award Total §
Min (non-zero)
Average
Median
Max

Award Total % of Total Pay
Min (non-zero)
Average
Median

Max

http:/acqdemo.hci.mil

&

5 o s s &
3

4 Analyzed Population 88 56 2% 7

5 Average OCS 723 746 655 783
6 Average Delta OCS 12 11 10 21
7 Alpha 1(CRI) 0.7067 1.0000 0.1999 0.1708
8 Alpha 2 (CA) 0.2415 02788 0.1778 0.1723
9 Salary Increase $

10 Min (non-zero) $1 $1 $1 $1.655
11 Average $1.387 $1.363 $1.476 $1.255
12 Median 843 0 $1693 $1.655
13 Max $6.494 $8.494 $2.939 $2.819
14 Salary Increase 3 of Basic Pay

15 Min (non-zero] 0.00% 0.00% 0.003%2 166%
16 Average 166% 1.65% 183% 1.08%
7 Median 11432 0.0032 2m% 1.66%
18 Max 13.06% 13.06% 3.59% 2.13%
19 Supervisor Differential

20 Number Receiving 2 2 0 0
21 old % Average * 7.40% 6.50%

22 new 3 Average ™ 6.503¢ 6.503¢

2 Flags

24 Override CRI 0 ] 0 0
2 Override CA 1 1 0 0
2 Disable Rollover (0] 0 ] 0 0
27 Force Rollover (2) 0 0 0 0
28 Control Points

29 1 with CP Entered 2 5 5 2
30 # Stopped At CP 3 1 0 2

H CAI Split to Salary

32 1 with Split Entered 0 ] 0 0
33 Averaae Solit % Entered

34 Carrpover Award $

35 # Carry Over Awards 29 20 [ 3
36 Min (non-zera) $214 $218 $214 $1.891
k7 Average™ $2.242 $2.567 $1.195 $2.174
38 Median™ $1.357 $1.31 $1.016 $1.894
39 Max $16,682 16,682 $2.556 $2.736
40 Carryover Award % of Basic Pay
41 Min (non-zera) 0.19% 0.39% 0.19%
42 Average™ 2.25% 2.50% 126%
43 Median™ 179% 184% 1612
a4 Max 10.43% 10.43% 179%
45 CA Award §
46 Min (non-zera) $10 $1.282 $10 $1.669
a7 Average $2.365 $2.772 $1.500 $2.205
48 Median $2.286 $2.308 $1502 $1.956
49 Max 8,591 $8,591 $2.608 $2,842
50 CA Award % of Total Pay

51 Min (non-zera) 0.01% 164% 0.01% 167%
52 Average 2.50% 284% 183% 2.22%
53 Median 235% 254% 187% 2.1%
54 Max 6.96% 6.96% 3.18% 3.09%
56 Award Total $

56 Min (non-zera) $10 $1.500 $10 $1.669
57 Average $3.104 $3.688 $1.787 $3.136
58 Median $2.286 $2.645 $1.750 $2.842
59 Max $25,273 $25.273 $4.825 $5.494
60 Award Total % of Total Pay

61 Min (non-zera) 0.01% 164% 0.01% 167%
62 Average 3.24% 3.73% 213% 3.92%
63 Median 272% 2.75% 213% 2.14%
gg Max 15.80% 15.80% 3.38% 6.16%
66 ~Supervisor Differential and Carryover awards average and median only calculated over those receiving them
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Payout Charts Worksheet
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The Payout Charts worksheet displays the payout statistics provided in the
Payout Statistics worksheet in chart form.

The charts are bar graphs showing average percent and average dollar
amount by pay pool.

A trend line shows the average across pay pools. This worksheet contains
the following charts

Alpha 1 by Pay Pool e Alpha 2 by Pay Pool

Average Salary Increase % by Pay Pool * Average Salary Increase S by Pay Pool
Average Carryover Award % by Pay Pool * Average Carryover Award S by Pay Pool
Average CA % by Pay Pool * Average CA S by Pay Pool

Average Total Award % by Pay Pool * Average Total Award $% by Pay Pool

33

http:/acqdemo.hci.mil



HEEDemo

Payout Stats by Group Worksheet

Without Wildcard Stats
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Payout Charts by Group Worksheet
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m
EEEDemo

The Payout Charts by Group displays bar charts of the statistics (S and %)
provided by Payout Statistics by Group worksheet. A trend line shows the
average across pay pools. This worksheet contains the following charts:

* Average Salary Increase by Career Path

* Average Salary Increase by Band

* Average Salary Increase by Career Path/Band

* Average Total Award by Career Path

* Average Total Award by Band

* Average Total Award by Career Path/Band

e Average Carryover Award by Career Path

* Average Carryover Award by Band

* Average Carryover Award by Career Path/Band

The blue bar charts reflect the statistics that are dependent on population
receiving. The green bar charts (on the following page) reflect the
statistics across the whole population (except Presumptive Due to Time).
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Payout Charts by Group Worksheet
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Payout Charts by Wildcard Worksheet
The Payout Charts by Wildcard worksheet displays bar charts of the

Acqm
N
B EEDemo

statistics (S and %) for the Wildcard selected for analysis on the Payout

Statistics by Group worksheet. A trend line shows the average across

groups. Similar to the Payout Charts by Group, there are blue bar charts
dependent on receiving the increase vs green bar charts for the entire

population. This worksheet contains the following charts:
* Average Salary Increase by Wildcard

* Average Carryover Award by Wildcard

* Average Total Award by Wildcard

Without Wildcard Stats

W Wildc:ard Stats

Aiages Basn o Fll Poputaon sxciing Prasmpiv O Tine eviago Bosod o Full Popuiation exclucion Prasunpies Dot Tme

,,,,,,,,,,

EEEEEE

S R T T

il arEnnnuiis
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Funding Statistics Worksheet

* Provides statistics on funding
amounts budgeted and
allocated through the pay

pool process.

The budget is represented in
the Inputs section and the
allocations are represented in
the Outputs section.

Data is provided across pay
pools and by individual pay
pool.

C D E [E] H

1 Funding Statistics
‘¢-53\\

2 o & & &
=
4 Total Employees Sd 62 25 T
& - Retained Employees 13 17 1 1
B - Presumptive SPL =] =] 1] 1]
T Sum of Basic Salary [cap to band max] $£8.970,835 $6.076.037 $2.173.140 $721.655
8 Sum of Adjusted Basic Salary [cap EXIV $£5.970.835 $6.076.0357 $2.173.1d0 $721.658
g First AcgDemo Cycle ul ul ul ul
10 Rollover CRI remainder to CA 2 Yes Mo fes
1 Use OCS based Control Points 1 YVes Mo Mo
12 OCS Control Point Target SPL
13 Proration Plan nla nla nla
i Time Off Plan Discretion non-CCAS nla
15
& Inputs
17
e Salary Increase [CRI) 2,540 2,400 2,200 2,260
13 CRI Set-aside (¥ of total) 2782 0.000: 10,000 G132
20 = Budgeted Award [CA) 23T 2500 2,000 2,500
21 B o CA Funds from CRI Carryover 0278w 0.313 0.000: 0.133
22 Award Spending > in CCAS 21214 2,250 1.8000 2,000
23 Award Set-aside 0.000: 0.000: 0.000:
24
25 Salary Increase [CRI) h ¥212.015 F146,722 #45,357 #16,303
2B CRI Set-aside $5.893 30 4,893 41,000
27 $ Budgeted Award (CA) $213.403 $151,900 $43 482 $18.041
28 % Award Spending in CCAS #130,262 136,711 33,017 #4434
29 Award Set-aside 30 30 30 30
30
Al Beta 1[CRI Target) o 1 1
32 Beta 2 [CA Target] 1 1. 1.
33
34 Cutputs
55
36 Alpha 1 0.7255 1.0000 0.1333 01705
a7 Alpha 2 0.2433 0.2785 01774 01723
38
29 Approved CRI $122.035 #7634 $36,903 43,785
40 CRI CRI Carryover Awards $65,023 $51,335 $7.067 #6521
41 Spent CRI 157,058 127 676 $44.076 $15,306
42 CRI Remainder [rolls to CA if ¥es on row 24,960 13,046 4,91 1,003
43
44 CA Awards #2085,156 #155.220 #37.504 $#15.432
45 CA Total Awards F273.173 206,555 Fdd,671 $21.953
45 Remainder Aw ard N $550 $536 #10 34
47 Non-CCAS CA Spending 24,756 #13.130 5,958 3,608
48
49 CRI * of Basic Salary spent on Salary Incred 1360 126 1,70 122%
S0 % of Basic Salary spent on Carryover 0.721 0.54 0,33 0.90:
51 2 of Basic Salary unspent 028 037 0.23: 0.1
52
L5fg) > of Adj Basic Salary Spent in CMS 2.32% 255 173 21
R4 CA 3 of Adj Basic Salary unspent rollover 0.0 000 0,00 0,00
5] 3 of Adj Basic Salary for outside CMS 0.2 0,25 0277 0.50
56
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Funding Charts Worksheet

* The Funding Charts
worksheet displays bar : Sy e (0 ot b o o sy sy et

charts of the statistics (%) |: |..

provided by the Funding | | ’

Statistics worksheet. A I

trend line shows the -

This worksheet contains |2 | o gty o e

average across pay pools. |: i
the following charts by

pay pool(s): -
* Salary Increase (CRI) B
Funding

* CRI Expenditure — 2
carryover amount - [ I ] a2 (CA by Pay oo

identified | I
* Award (CA) Funding N
 Award Expenditure = I l
» Alpha 1 (CRI) e H = [N :

* Alpha 2 (CA)

E & & g & & B
£ #F  F F F F F




Net Draw Analysis Worksheet

The Net Draw Analysis worksheet provides a summary of net draw

statistics by career path/band, career path, broadband, Wildcard, and the
entire population. This analysis considers the difference between the

amount of an employee’s payout and the dollar amount that was
contributed to the pay pool fund based on the employee’s basic salary,
adjusted salary, and the funding levels. The formula is as follows:
Net Draw % = (Received — Contributed) / Basic Pay

Without Wildcard Stats

1

A

B

I Only visible rows from Data tz

©

D

E

F

G

>ups of employees.

A B cD E F G H I
1 | [ Only visible rows from Data tab Net Draw Analysis
s Net Draw is a measure used to compare the payouts between groups of employees.
Net Draw % = (Received — Contributed) / Basic Pay*
*Basic Pay is limited to band max for retained pay employees
= Analyzed Population excludes presumptives due to time
4 ~
Number of
Employees Net Draw
= Analyzed Received Contributed Basic Pay %
6
7 Entire 88 $ 395214 § 378431 $ 8,502,605 0.20%
15 Band
16
17 1 2 $ 3199 $ 2,469 $ 61,727 1.18%
18 2 22 $ 88248 $ 60,718 $ 1,349,854 2.04%
19 3 43 $ 169,711 $ 182,282 $ 4,110,240 -0.31%
20 4 21 $ 134,056 $ 132,963 § 2,980,784 0.04%
21
22 Career Path/Band
23
24 NH-2 13 $ 69656 $ 40,201 $ 880,358 3.35%
25 NH-3 32 $ 135273 $ 146,269 $ 3,299,286 -0.33%
26 NH-4 17 $ 108,325 $ 111,889 $ 2,527,580 -0.14%
27 NJ-1 1 $ 1689 $ 1,100 $ 27,500 2.14%
28 NJ-2 2 $ 1,853 $ 4872 $ 113,223 -267%
29 NJ-3 6 $ 15,067 $ 20,188 $ 455,109 -1.13%
30 NJ-4 4 $ 25731 $ 21,074 $ 453,204 1.03%
31 NK-1 1 $ 1510 § 1,369 $ 34,227 0.41%
32 NK-2 7 $ 16,739 § 15,645 § 356,273 0.31%
33 NK-3 5 $ 19,371 § 15,825 $ 355,845 1.00%
34
35

"
: Wildcard Stats
sloyees
3 . e . : ) time
4
-

Number of

Employees Net Draw
5 Analyzed Received Contributed Basic Pay %
6
7 Entire Population: 88 3 205214 § 378431 § 8,502,605 0.20%
15 Band
16
17 1 2 3 3190 § 2460 § 61,727 1.18%
18 2 22 $ 88248 § 60.718 § 1,340,854 2.04%
19 3 43 $ 169,711 § 182282 § 4,110,240 -031%
20 4 21 $ 134,056 § 132063 § 2,980,784 0.04%
21
22 Career Path/Band
23
24 NH-2 13 $ 60,656 § 40201 § 880,268 3.35%
25 NH-3 32 s 135273 § 146.269 § 3,299,286 -0.33%
26 NH-4 17 $ 108.325 § 111889 § 2.527.580 -0.14%
27 NJ-1 1 5 1689 § 1100 $ 27.500 214%
28 NJ-2 2 5 1853 § 4872 § 113,223 -267%
29 NJ-3 6 5 15,067 $ 20188 $ 455109 113%
30 NJ-4 4 $ 25731 § 21074 $ 453,204 1.03%
31 NK-1 1 $ 1510 $ 1369 $ 34,227 0.41%
32 NK-2 7 $ 16739 $ 15645 $ 356,273 0.31%
53] NK-3 5 $ 19371 § 15825 $ 355,845 1.00%
34
35
36
37 53,260
38 721,656
39 423,384
40 491,729
11 449 450
12 142,041
43 612,367
44 SP-1-Monday 919,528
45 SP-2-Tuesday 809,012
46 SP-3-Wednesday 978,147
47 SP-4-Thursday 1.176.764
48 SP-5-Friday 953,689
49
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Net Draw Analysis Worksheet

Net Draw % = (Received — Contributed) / Basic Pay

Calculation Example:

* An employee earns $60,000 as a
basic salary

e 55,000 locality pay

* The pay pool funds CRI at 2%

« CAatl.5%.

* The employee therefore contributed $2,175 (60,000*0.02+65,000*0.015).

* The employee received a $2,500 (CRI increase plus carryover plus award)
payout resulting in a positive net draw — she received a greater payout than
what she contributed to the pay pool fund.

* Had the employee received a $1,000 payout, her net draw would be a
negative.

-
HEEDemo
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Net Draw Charts Worksheet

* The Net Draw Charts worksheet displays bar charts of the statistics (%)
provided by the Net Draw Analysis worksheet. This worksheet contains the
following charts:

e Net Draw by Career Path/Band
e Net Draw by Career Path
e Net Draw by Band
e Net Draw by Wildcard
* The bars above the axis are groups that have contributed less than they

received in payouts. Groups with bars below the axis contributed more
than they received in payouts.

Net Draw by Career Path/Band

Net Draw by Career Path ‘

0.008 4
3.35%

0.03 Net Draw by Band Net Draw by Wildcard 1
0.025 4 0.05 -

2.04% 004 3.80%

0.03
l 0.02 4

001 4

1.18%

-0.33%

0.57% 0.65%
0.48% 027% 0.26%

0.00%
0.04% 0.36% -0.27%

-0.01 4 -0.65% -0.67%

-0.48%

0.31% 002 | -147%

1 2 3 4 9009 9009-2 9008-HQ SP-3-Wednesday Supervisors
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Enhanced Flexibilities Worksheet

* The Enhanced Flexibilities worksheet informs the user as to the extent of
usage for different flexibilities and capabilities within using the Time Off
Awards (TOA), CA Proration, and Salary Split.

Without Wildcard Stats

4 ] [ D E F G H J K
1 [ Only vis ke Data tabk rows Enhanced Flexibilities
2
3 Time-Off Awards Proration Salary Split w W' I d
‘ lHacar 5
Numberof | Mo. Receiving % Receiving  Total Time-OFf Average Number  Average Pct |  Number Average
5 Emplogees Time-OFf Time-Off Hours Time-OFf Prorated Proration™ Split Split® .
8
7| Ente Papulatio 88 2 2.3% 43 215 0 [ o B C o £ £ H J K
3 Pay Pool 1 ™ Only vis ible Data tsb rows Enhanced Flexibi
i 2
il 9000 s6 1 w 7.0 0 [ 3 Time-Off Awards Proration Salary Split
12 3009 25 1 26 260 o o 4
1 9399 7 [ 0 0 0 Number of | Mo. Receiving % Receiving  Total Time-Off Average Number  AveragePet | Number Average
}g e Dot 5 Employees Time-OFf Time-OFf Hours Time-OFf Prorated Proration™ Split Split
areer Patl 5
& 7 Entire Populatio 88 2 2.3% 43 215 0 0
WM 62 2 43 215 0 0 8
L:] M 13 o o o o g Pay Pool
\oNK 1 o 0 0 0 0
20 il 3000 55 1 18% 7 .0 [ 0
21 Band 2 3009 25 1 26 260 o o
&z 1§ 9999 7 0 0 0 0
FEI 2 [ 0 0 0 #
24 z 22 1 v 170 o o bl Career Path
25 3 43 1 2 250 0 i B
26 r 21 o ] o 7 MH B2 2 43 215 o o
27 B M 13 o o o o
2|  CareerPathiBand B WK I 0 o o 0
2 20
30 MH-2 13 1 At 1wo o 0 21 Band
kil NH-3 32 1 % 250 i o 2
2 WH4 i o i o i 230 1 2 a a a o
23 N1 1 o 0 0 0 2 2 22 1 7 w0 [ 0
3 w2 2 a 0 o 0 % 3 43 1 % 60 0 0
T 6 a 0 0 0 55 4 21 0 o o o
36 -4 4 o o o o
M e o i g B g gg Career PathiBand
Bl hez 7 o 0 o 0 e B 1 7 o o 0
F 5 o 0 0 0 I w3 32 1 26 260 a 0
b 2 1 0 0 0 i
2 3| M 1 0 o o i
43 34 -2 z o o o o
44 AT [ 0 0 0 0
45 ki3 M- 4 i a a 0
46| " Seatisicis based on those receiving T Mk 1 0 o o o
L 7 0 0 0 i
35 2 = = a
4
41] Wildcard 1
4
4 o
44 o
45 o
o
26
o
o
v
o
o
o
o
Supenvisors o
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CP-B Counts Worksheet

* Displays counts by career path and broadband combinations overall and by
pay pools.

A B c E F G

: Counts by Career Path and Broadband
\\
$ &
2 o' o o &&
3
4 Number of Employees 94 62 25 7
5
6 Count of Employees by Career Path and Band
7
8 NH-1 0 0 0 0
9 NH-2 14 12 2 0
10 NH-3 34 21 9 4
11 NH-4 17 10 5 2
12 NH Total 65 43 16 6
13
14 NJ-1 1 0 1 0
15 NJ-2 2 1 1 0
16 NJ-3 8 6 2 0
17 NJ-4 4 4 0 0
18 NJ Total 15 11 4 0
19
20 NK-1 1 0 1 0
21 NK-2 7 4 3 0
22 NK-3 6 4 1 1
23 NK Total 14 8 5 1
- 44



Salary Worksheet

* Provides the average salary
by career path and
broadband for the entire
population and for each pay

pool.

B

C

E

Average Basic Salary by Career Path and Broadband

Retained Rate Employee Basic
Salary includes locality pay

&

&
2 o s s &
3
4 Number of Employees 94 E2 25 7
&5
E Average Basic Salary for New Pay Year
7
8 MH-1
9 MH-2 $7d.372 $76,835 $33.240
i} MNH-3 #109.853 116,642 $#102 601 30,580
n MH-4 154,744 161,453 #142.031 152,831
12 HNH Total $113.955 #1159 $109.521 $111.330
13
14 MJ-1 $28,663 $28.863
5 M-z 37,128 $52.807 $61.443
& MJ-3 $53,502 $32,0M 32,007
17 M.J-4 122,333 #122.333
1 HNJ Toral $83.900 $39.470 $63.582
19
20 ME-1 $35.603 $35.603
21 MK-2 $55, 766 $60,352 48,512
22 ME-3 $83.135 $81977 $63.751 101,148
23 NK Total 466,056 $71.479 450,359 $101.148
28 Average Basic Salary for Current Pay Year
26
27 MH-1
28 MH-2 #71.621 #7423 $56.612
29 MH-3 #106, 738 #13,733 35,665 55,179
a0 MH-4 150,734 F157.605 $138,196 #147,723
il NH Total $110.681 $112.882 $105.762 $108.023
2
33 MJ-1 27,500 $27.500
3 MJ-2 $56,612 52,507 $60.416
is) MJ-3 $68,392 #30,635 #1664
36 THJ- 113,674 #113.674
ar NJ Toral $68.437 $37.756 $62.861
a8
] ME-1 $34.227 34,227
40 ME-2 54,273 53,533 47,266
41 ME-3 $51.278 #80,036 $67.000 #100,523
42 NK Total $64,418 $69,787 $48.605 $100,523
44 Percent Change in Average Basic Salary
45
4 NH-1
47 MH-2 3687 3.7 &6
43 MH-3 2.9 2.6 4.0 2.7
49 MH-4 2.7 24w 2.8% 3.5%
50 NH Total 3.0x 2. 7% 3.6% 31
51
52 M.-1 5.0 5.0
3 M-z 0.3 0.0 17
54 M.J-3 13 154 0.4
55 M- 2.2% 2.2
56 NJ Toral 17 18 12x%
57
53 ME-1 4.0 4.0
59 ME-2 ZTm 2. 3.3
B0 ME-3 237 e 4.1 0.62%
E1 NK Total 2.5% 2.4 3.6 0.6z
63
B4
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Rail Report Worksheet

* The Rail Report Worksheet displays a report of rail zones, an OCS chart, a
table, and a pie chart showing the distribution of the Performance Rating
of Record across career paths and overall, that is used for the Aggregate
Report generated from the Add-Ins menu bar.
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F
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K L M N 0

P

Q

Rails Report

Performance Rating of Record

Rail Zone

NH
Number

Percent

Number

NJ
Percent

NK

Number

Percent

Total
Number Percent

Definition of Rail Zone

A
ct
cz2

B

SPRNO AR W N

0
12
45

5

0.0%
19.4%
T28%

8.1%

2

2
9
0

15.4%
15.4%
69.2%

0.0%

0
0
12
0

0.0%

0.0%
100.0%

0.0%

2 23%
14 15.9%
67 76.1%
5 57%

Inappropriately compensated above the rails
Appropriately compensated between the rails = SPL
Appropriately compensated between the rails <= SPL
i compensated below the rails

1" Total

62

100.0%

13

100.0%

13

100.0%

100.0%

Counts do not

include personnel receiving presumptive OCS ratings due to time

Rails Report

17 Rail Zone

NH
Number

Percent

Number

NJ
Percent

NK

Number

Percent

Total
Number Percent

Definition of Rail Zone

18 A
19 4
20 B

0
57
5

0.0%
91.9%
8.1%

2
1
0

15.4%
846%
0.0%

0
13
0

0.0%
100.0%
0.0%

2 23%
a1 92.0%
5 57%

Inappropriately compensated above the rails
Appropriately compensated between the rails
Inappropriately compensated below the rails

2 Total

Basic Pay

62

100.0%

13

100.0%

13

100.0%

88 100.0%

Counts do not include personnel receiving presumptive OCS ratings due to time.

$160,000

$140,000

$120,000

$100,000

580,000

$60,000

$40,000

$20,000

30

30

Rating of Record

Number

NH
Percent

Number

NJ
Percent

Number

NK
Percent

Total

Number

Percent

Unacceptable (Level 1)
Fully Successful (Level 3)
OQutstanding (Level 5)

0
58
4

0.0%
935%
6.5%

2
10
1

15.4%
76.9%
77%

0
12
1

0.0%
923%
17%

23%
90.9%
6.8%

Total

Modal

62

100.0%

13

100.0%

13

100.0%|

100.0%

3

3

3

3

Counts do not include personnel receiving presumptive OCS ratings due to time

Performance Rating of Record

W Unacceptable (Level 1)

= Fully

2.3%

= Ou di

ful (Level 3)

(Level 5)
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* The Aggregate Report generated from the Add-Ins menu bar

Rail Report Worksheet

File Home Insert Draw Pagelayout Formulas Data Review View Automate Add-ins Help Acrobat {7 Comments | Naf1EIEI
o o ) ) ) n D .
= = = I ] Zl q MainMenu W Wildcard Stats ?E Customize Output Chartsfl [5] Generate Aggregate Report z Highlight
<
Custom Toolbars ~
o
Save Three-slide Aggregate Report
Y % Payout Statistics by Group
AcqDemo Results FY24
&« 2> v 1 T« CCAS » 2024 > 9000 v C Search 9000 »p
Payout Statistics by Group
Organize * New folder =- 0 (Presumptive due to time excluded)
N Name - Date Modified v -~ Averaged Across Only Those Receiving the Payment —-—-——- |
Y Home Number of . . n v . v :
Empioyens | nverage Deta|  umbr | e | | o | !
ﬂGaHeyy I No items match your search. Analyzed Av-l-i.ocsi ocs Receiving. i s % Receiving i $ i % Receiving i $ i %
Entre Poputatin - ns 1o 2 | osan | oasew w | owae | o2em 6 | s | o2em
CarerPaBand
v @ Jerold - DAU
wa 13 w05 2 s omr
i © 77 i w s o
> 7 Apps N4 I %7 I n 2413 Too%
i 180 ‘o i o sz .
2 2 P 20 b s s Rails Report
> 7 Attachments s o o 2 s rem
: oo : : AcgDemo Results FY24
> @ Desktop N2 7 a3 I 5 1,065 213%
N s ot i H o o Rails Report
> ~ Documents NH N NK Total
NoTES: RailZone | Number Porcent | Number Percent | Number Percont | Number Percent | Defintion of Rail Zone
1 average based on those receivng, % weighted by basic pay (capped at band max) to include empl A o 0.0% 2 15.4% 0 0.0% 2 23% Inappropriately compensated above the rails
File name: PAT Aggregate Report.pptx v 2average based on those receiving, % weighted by adjusted basic pay (capped at EX-IV cap) and c 57 1.5% 11 846% 1 1000% a 52.0% | Appropriately compensated between the rails
of H s o 0o% | 0 oo | 5 s7% | napproprats compenseted beowtne ais
Save as type: PowerPoint Presentation (*.pptx) ~ Total o2 000% | 1 T000% |13 1000% 5 10.0%
T ersanne ecebiTg presumpEv OCS ating Goe o e
Performance Rating of Record .
A Hide Folders Tools ¥ Save Canc:
AcgDemo Results FY24 oo /
™
Performance Rating of Record
™
NH NJ NK Total 000
Rating of Record Number Percent Number Percent Number Percent Number Percent. f
Unacceptable (Level 1) o oo%| 2 154% 0 0o%| 2 23%) o
Fully Successtul (Lovel 3) | 58 s 10 oo 12 P 90.9% w0 o
Outstanding (Level 5) 4 65%| 1 7% 1 7% 6 6.8%| ==
62 100.0%| 13 100.0%) 13 100.0%) 88 100.0%)| 000
©
Modal [ p I 3 i 3 3 v w W w
ocs
—uR s —lR e e e

Performance Rating of Record

6.8% 2.3%

Pil-Do not distribute/CUI
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Pay Pool Analysis Tool (PAT) User Guide

® Th e 2024 ACq De Mo PAT U ser United States Department of Defense (DoD)
G u id e d eta I IS h ow to use t h e Acquisition Workforce Demonstration Project (AcgDemo)
fu n Ct I ona I It I €s Of th e PAT an d Contribution-based Compensation and Appraisal System Software

(CAS2Net)

describes the available reports.

* Available on the AcqDemo
Website:
https://acgdemo.hci.mil/docs
/2024%20AcqDemo0%20PAT %2

OUser%20Guide.pdf PP WIS AcqDemo Task Ordet O
* And posted to Pay Pool Notices
on 1 OCt 2024 PAY POOL ANALYS\IS;;?\?}E (PAT) USER GUIDE

Updated September 2024

Prepared for:

United States Department of Defense (DoD)
Acquisition Workforce Demonstration Project (AcqDemo)

Prepared by:
General Dynamics Information Technology (GDIT)
The views, opinions, and findings contained in this document are those of the authors and should not be

construed as an official Department of Defense position, policy, or decision unless so designated by other
official documentation.
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End of Cycle Key Dates

12345 12ch2‘;§%4'{@£
678910112 3456789 1011 1
OCT | 20 |y334115 16 1718 19) | © " | 22 [10[11]1213 1415 16 2515 16 1718 1920 21 e
20212223 242526 23|17 22 23 2425|2627 28
2112728 2030 31 26/29 30 31

|
(4]
Lo
(1]
m
<
(-]
=
-t

Day Action By

CAS2Net activates end-of-cycle modules: Appraisal Status, Offline
Interface and Previous Cycle Data, Sub-Panel Meeting, CMS Online, PMO
Macro-Free Sub-Panel Meeting, Macro-Free CMS

Pay Pool Notices with 2024 Macro-Enabled Sub-Panel Meeting

Tuesday 1-Oct-24

Spreadsheet, 2024 Macro-Enabled CMS, and 2024 Macro-Enabled PMO
Pay Pool Analysis Tool
Thursday |21-Nov-24|Pay Pool Notices with Not Final Reports / Data Complete Reports PMO
Initial Upload DAF & DCMA 6 Dec 2024 Pay Pool
Friday |13-Dec-24|**subjectto component/command earlierinitial upload date** | Administrators
Final Upload DAF 20 Dec 2024 Pay Pool

Wednesday 8-Jan-25 **subject to component/command earlier initial upload date** | Administrators
Sunday | 12-Jan-25|First full pay period in January (12 Jan to 25 Jan)
Friday 17-Jan-25|Pay Pools completed PMO
Tuesday | 21-Jan-25|Paytransactions posted to regional pay offices PMO
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2024 Open Forum Schedule

v 04 January, 1pm — 2:30pm ET: CCAS Pay Transactions for Regional Pay Offices

v 01 February, 1pm — 2:30pm ET: CCAS Grievance and Archive/Transfer

v 07 March, 1pm — 2:30pm ET: Assigning Mandatory Objectives, Mid-Point Review, Additional
Feedback, and Closeout Assessment

v 04 April, 1pm — 2:30pm ET: Communicating with AcqDemo Program Office on CAS2Net and
CCAS Issues

v' 02 May, 1pm — 2:30pm ET: Reports — FY-based Reports & Current Settings Reports

v 06 June, 1pm — 2:30pm ET: Macro Free Sub Panel Spreadsheet and Compensation
Management Spreadsheet (CMS) Introduction

v" 11 July, 1pm — 2:30pm ET: Creating Sub-Organization Levels and Assigning Sub-Panel
Managers, and User Role Assignments

v 01 August, 1pm — 2:30pm ET: CCAS Spreadsheet Test Schedule (Offline Sub-Panel Meeting
Spreadsheet, Offline CMS, Macro Free versions, and CAS2Net Online versions)

v 05 September, 1pm — 2:30pm ET: Post Cycle Modules (Appraisal Status, Offline Interface,
Previous Cycle Data, Sub-Panel Meeting and CMS Online)

v’ 12 September, 1pm — 2:30pm ET: Transfer, Archive and Post Cycle Activities

v 19 September, 1pm-2:30pm ET: Changes in Sub-Panel Meeting and CMS

v’ 26 September, 1pm-2:30pm ET: Macro Free Sub Panel Spreadsheet and Macro Free CMS

v 03 October, 1pm-2:30pm ET: Discrepancy Reports

v 10 October, 1pm-2:30pm ET: Lock/Unlock Supervisor 1, Sub-Pay Pool and Pay Pool

v 17 October, 1pm-2:30pm ET: Pay Pool Analysis Tool (PAT)

o 07 November, 1pm-2:30pm ET: Initial and Final Upload

o 21 November, 1pm-2:30pm ET: Not Final Reports and Data Complete Reports

o 05 December, 1pm-2:30pm ET: Grievance/Grievance Window




Open Forum
Questions?

AcgDemo.Contact@dau.edu

Erin.Murray@dau.edu

jerry.lee@dau.edu
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